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About This Guide  

The ‘AESO Enterprise Data Portal’ is a suite of online portals meant to provide a unified platform for secure 
information exchange with external stakeholders. The ‘Customer Connections Portal’ is part of that suite, 
meant for exchange of data related to the Connection, Behind-the-Fence, and Contract processes. The 
Project Data Update Package (PDUP) submission process is one of the processes that have been built in 
the portal. The Transmission Facility Owners (TFO) and market participants (MPs) will use this portal at 
different stages of a project to submit PDUPs to the AESO.  

This guide is specific to the functions performed by users to make a successful PDUP submission. The 
document will provide guidance on: 

• How to request a Bus or Facility code from AESO 
• How to perform PDUP submissions in the portal  
• Notifications while performing the above functions 

 

Note: In this document, the Customer Connections Portal will be referred to as CGA Portal or only Portal. 
Customer Connections Portal and CGA Portal are the same. 

PDUP Submitter and External user terms are used interchangeably, which means the non-AESO portal 
user who are responsible for submitting the PDUP. 

Screenshots have been created using dummy data and users and usernames have been stricken-off for 
privacy reasons. 
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1. Request Bus or Facility code from AESO  
The externals users (TFO, study consultant etc.) that are responsible for PDUP submissions can request 
for Bus and Facility (Substation or Transmission Line) code via portal prior to their PDUP submission. The 
notification of request goes to the Project Engineer (PDUP Analyst) within AESO, who then provides the 
required code.  

Code Request to AESO (only in stage 2, 3, 4 & 5)
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Login to portal > 
Project > Stage 

• Open & fill the required 
request form (Bus, 
Facility Code 
Transmission line or 
Substation)

• Move the request to 
next stage

StopView the codes provided 
by the AESO

Notify PDUP analyst that a 
new request is submitted 

Provide the code, as 
requested

Notify PDUP submitter that 
the code has been updated in 

the portal by AESO 

Stop

 

1.1. Initiate Code Request   
1. Click on AESO Apps to see the project you are working on. 
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2. Open the project where you need to request the code.  

 
3. Open the required stage of the project. 

 
4. Open the required code request form  

Bus Code Request / Facility (Transmission Line) / Facility (Substation) 
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1.1.1. Bus Code Request  

1. Open a New ‘Bus Code Request’ 

 
2. An empty Bus code request record will get created 
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3. The record can be filled in using either the List view or the Form view within the portal: 
a. List view, with one click under the column name. ‘AIES Topological Nodes’ to be value 

will be provided by the AESO, so leave it blank. Fill rest of the fields and save

 
b. Form view, click on arrow or double click on the record to open the record in form view. 

 

 
1.1.2. Facility Code Request  

Facility code request (FCR) can be submitted for Transmission Lines or Substations. The process of 
opening the form, filling, submitting etc. will remain the same as the Bus Code Request except the 
‘Facility Code’ field value will be provided by the AESO. 
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1.2. Submit Code Request   
1. After the request fields are populated submit the request to the AESO by moving the stage from 

‘Initiate’ to ‘Submitted to AESO’  

 
2. Confirm the request submission. 

 
3. Multiple requests can be submitted from list view by selecting the records for submission and 

then using the SUBMIT button. 
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1.3. Close Code Request   
1. The AESO project engineers will get notified when a request is submitted. and they will provide 

the ‘AIES Topological Nodes’ or ‘Facility Code’ value to fulfill the request and move it to ‘Close’ 
stage.  

 
 

2. When closed, the system will generate a notification to the external user, so they can login to the 
portal to look up the code. 
Examples of email notifications when AESO provides codes:  
 
Bus Code: 

 
Facility Code for Transmission Lines: 
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Facility Code for Substations: 

 

1.4. Remove Code Request  
A code request can be removed before it is submitted to AESO. To do that, 

1. Select the record to be removed and click ‘Deactivate’.

 
2. Confirm the deactivation, which will remove the request. 

  



 

Version 1.0 Page 11 Public 
 

2. PDUP submission to AESO 
An external user (TFOs, study consultant etc.) is responsible to create the data for PDUP submission in a 
stage of a project. Each PDUP goes through a business process flow: 

Initiate > In Review > Accept > Close 

Based on the stage of the project, the PDUP submission may or may not require data forms submissions. 

PDUP submission types Stage 1 Stage 2 Stage 3 Stage 4 Stage 5 
PDUP Submission only with attached docs Yes Yes Yes Yes Yes 
PDUP Submission with data forms No No Yes Yes Yes 

 

PDUP – PDUP Submission 
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Start

Generate PDUP # with 
Facility Equipment form

Login to portal > 
Project > Stage

Create new PDUP > 
enter Energization # 

and comments & 
Save

Fill Facility 
Equipment form and 

equipment list as 
needed & Save

Fill equipment 
specifications in the 

mandatory forms 

Generate all the 
mandatory forms for 

the listed 
equipments

If needed, fill the 
optional forms:

- Topological Nodes 
- Mutual Coupling 

Attach the required 
documents including the 
coversheet with APEGA 

member’s signature.

SUBMIT the PDUP 
package by moving the 

PDUP stage to ‘In Review’

Successful form 
validations?

Notify AESO’s PDUP 
Analyst about PDUP 

submission.

Show errors in 
submission

Rectify the errors

Yes No

Stop
Stage 1 or 2?

No

Yes

  

2.1. Initiate PDUP data creation 
2.1.1. General Tab 

1. Open the project and then open the stage where PDUP needs to be submitted. The external user 
must take care that they create PDUP in the required stage as the system does not restrict any 
stage from PDUP creation. 

2. Click ‘+New CGA PDUP Submission’ that will open a new PDUP form 
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3. Fill the fields under ‘General’ tab of the form and ‘Save’. The PDUP business process flow will show 

in its INITIATE stage. 
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Field name Mandatory Description 
Energization # Yes The serial number of the energization in the project. It must be unique value (1-99) 

within a stage. 
Author 
Comments 

No Optional field, only for external user to enter their comments pertaining to the 
PDUP. 

AESO 
Comments 

No Optional field, only for the AESO reviewers to enter their review comments. 

Acceptance 
Comments 

No Optional field, only for the AESO reviewers to enter their review comments. 

 
2.1.2. Upload document to the PDUP data  

Users can upload any supporting documents to the PDUP. They must use this function to submit the 
APEGA member attested copy of the coversheet with their PDUP. User should sign, stamp, scan & then 
upload the document to the PDUP before submitting it to the AESO. 

To upload, go to ‘Document’ tab and upload documents as needed. 

 

2.1.3. PDUP data forms  

PDUP data forms are required in stage 3, 4 and/or 5, depending on the project type.  

• External users need to enter the list of Facility Equipment first which guides the generation of other 
dependent forms within PDUP as separate tabs. E.g., if a ‘Generator’ is entered in the equipment 
list, then these forms (tabs) will get generated in the PDUP – Generator Control (mandatory), 
Energy Source (mandatory), Dynamic Simulation Model (mandatory), Control System (optional). 

• The user will need to populate further details in those dependent forms before making the 
submission.  

• The mandatory dependent forms will have records created automatically for the equipment 
mentioned in the Facility Equipment list. User will not be able to add any new record there for an 
equipment that is not mentioned in the Facility Equipment list. 

• The optional dependent forms will be empty. If needed, the external user will create records for the 
equipment in those forms. The user will be able to add or delete records in the form before 
submission to AESO. 

• The mandatory fields and forms should be completed before making the submission. 

The table below describes the forms that will get created based on the equipment entered in the Facility 
Equipment form. 
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2.1.4. Enter data in Facility Equipment form 

1. Click Facility Equipment tab.

 

Equipment Equipment type Control System Type Mandatory forms # of forms
per 

equipment 
per control 

system type

Optional forms # of forms
per 

equipment 
per control 

system type
Generator Generator Control  

Dynamic Sim Model
Energy Source

1
1
1

Control system form 1
1

Exciter Dynamic Sim Model
Control system 

1
1

Governor Dynamic Sim Model
Control system 

1
1

Stabalizer Dynamic Sim Model
Control system 

1
1

Generator Control Dynamic Sim Model
Control system 

1
1

Electrical Control Dynamic Sim Model
Control system 

1
1

Plant Control Dynamic Sim Model
Control system 

1
1

UVLS Dynamic Sim Model
Control system 

1
1

UFLS Dynamic Sim Model
Control system 

1
1

Other Dynamic Sim Model
Control system 

1
1

Compensator Series Compensator (static)
Shunt Compensator (static)
Reactor

Other Compensator 1

Compensator SVC (Static Var Compensator) Other Compensator
Dynamic Sim Model (only for SVC)

1
1

Transformer Auto
2-winding
3-winding

Transformer
      Auto
     2-winding
     3-winding

2 (A,A)
2 (P, S)

3 (P,S,T)
Load Static n/a Energy Consumers

Elements to MP
1
1

Load Motor Motor Control system form
Energy Consumers
Elements to MP 

1
1

Dynamic Sim Model 1

AC Line Segment AC Line Segment AC line segment 
Branches

1
1

For all equip Mutual Coupling
Topological Nodes

any #
any #

Generator 
DER

Generator 
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2. Click ‘+New Facility Equipment’ to enter the facility details.

 
3. Save the Facility details by ‘Save’ or ‘Save & Close’ button. 

 
4. The Facility code once entered cannot be changed, hence confirm the facility details are correct.
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5. After saving the facility details, sub-grid will appear below to add equipment list. Click ‘New 
Equipment’. An empty equipment record will get created to allow for equipment details. 

 
6. The record can be filled in using either the list view or the form view: 

a. List view, by one click under the column name. Fill rest of the fields and save.  
c. Form view, click on arrow or double click on the record to open the record in form view. 

 
7. Based on the equipment in the list, the mandatory dependent forms records will be created 

automatically. You will not be able to add any new record there for an equipment that is not 
mentioned in the Facility Equipment list. 

8. The optional dependent form tabs will also get created but the records will be empty. If needed, 
create records for the equipment in those forms. You will be able to add or delete records in the 
form before submission to AESO. The optional forms are: 

a. Topological Nodes form  
b. Mutual Coupling form 

9. Fill the forms that got generated – Mandatory as well as optional, if required 
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2.1.5. Fill out mandatory and optional dependent forms 

 

2.2. Submit PDUP data for review 
1. After the all the required forms are filled, submit the request to AESO by moving the stage from 

‘Initiate’ to ‘In-Review’  

 
2. Confirm the PDUP submission as the user cannot make any changes to the PDUP data after it 

moves to ‘In-REVIEW’ stage. 
3. The submission will generate email notification for the AESO reviewers who will review the 

submission. 
 

2.3. Accept PDUP data submission 
If the data submission meets the PDUP requirements, then the AESO reviewer will move the PDUP stage 
forward to ‘ACCEPT’.  
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2.4. Re-open PDUP for correction  
In case of deficiencies are found, then the reviewer will contact the external user via communication 
channel or other means and if needed, can choose to move the PDUP stage back to ‘INITIATE’ i.e., re-
open the case for the external user to make corrections.  

Note: Please refer to ‘User Guide for Communication Channel’ on how to use it. 

 

2.5. Close PDUP data submission 
After PDUP submission is accepted by AESO then reviewer will move it forward to ‘Close’. Once closed, 
no changes can be made to that PDUP submission.  
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3. Clone PDUP data forms  
External users (PDUP submitter) can clone (or copy) PDUP data forms from previous stages to latter 
stages. It’s helpful when the PDUP data for an equipment hasn’t changed much from the previous stage 
and can be used in latter stages too with minimal updates by the external user.  

• A PDUP can be cloned from, 
o Stage 3 to stage 4/ stage 5   
o Stage 4 to stage 5  

• Multiple PDUP submissions of previous stages can be copied into one PDUP of latter stage. 
• A PDUP can only be cloned once, it cannot be copied into multiple PDUPs within a stage.  
• The PDUP energization no. of the destination PDUP can be different than the source PDUP. 

 

To clone a PDUP from one stage to another: 

1. Create a new PDUP where the data forms will be copied over from previous stage. Follow the same 
steps as mentioned in section 2.1.1.  

2. After PDUP is created, click the ‘Clone’ button on top of the PDUP page. 

 

CGA – Clone a PDUP from previous stage
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Login to portal > 
Project > Stage > 

PDUP 
Start Stop

• Click ‘+New PDUP 
Submission’ to open 
new PDUP form

• Fill:
         - Energization #
         - Author Comments 
• SAVE  

• Click ‘Clone’ to 
copy from PDUPs of 
Previous stages

• Select the required 
PDUP

• SUBMIT

• Click ‘Clone Request’ tab 
to check cloning status 

• View the copied PDUP 
when cloning is complete

• Update the copied PDUP 
as needed
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3. List of PDUPs from previous stages will appear as options. Select the PDUP (one or more) to be 
copied and SUBMIT. 

 
4. Confirm your cloning request 
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5. Cloning process may take some time to complete. User can view the cloning status by clicking 
‘Clone Request’ Tab in the PDUP 

 

 

6. The data forms will get added to the PDUP after the cloning job is complete (Status = Complete). 
7. User shall then make changes to the forms as required before making submissions. 

Note: Clone function can only copy the data forms, not the attachments to the PDUP.  
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4. Download PDUP data  
Any Customer Connections portal user can download a PDUP package from the portal.   

• The download can be done at any stage of the PDUP business process flow. 

• The downloaded PDUP package will contain all the forms and document attachments that are 
visible to the user and are part of the PDUP package at the time of download. 

• The PDUP package always gets downloaded to the ‘Downloads’ folder of the user. Users can move 
the folder after the download is complete. 

• All the PDUP forms are downloaded into separate PDF documents. Any attachment to the PDUP 
is downloaded in their native file format. 

 

To download a PDUP 

1. Open the required PDUP that needs to be downloaded. 

 
 
 
 
 
 

CGA – Download PDUP as a package
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Login to portal > 
Project > Stage > 

PDUP 
Start StopClick ‘Create Download’

Confirm the download

View download 
status under ‘Zip 

Files’ tab

Double click to open 
the completed ‘ZIP 

file’ record 

Save the PDUP ZIP 
Package where 

needed
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2. Click ‘Create ZIP’ button on top of the PDUP page. 

 
3. Confirm your PDUP download request 
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4. Download process may take some time to complete. User can view the download status by clicking 
‘Zip Files’ Tab in the PDUP 

 
5. Once the download process is successfully completed, a notification is sent; only to the person who 

initiated the download. They can then login to the portal to fetch the zip folder. 
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6. If the download process fails, a notification is sent; only to the person who initiated the download.  
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5. Notifications to external user 
Email notifications are generated for the portal users based on certain triggers within the Customer 
Connection processes. The notifications are either sent to the whole team or an individual user. Here are 
the triggers that initiate notifications for External Users when working with the Customer Connections Portal 
for PDUP submission. 

Triggers Notification to  
Bus or Facility code request is completed by AESO External User’s Team  
PDUP reopened by AESO for corrections by external user External User’s Team  
When the download initiated by a user is complete  Only the user who initiated the download  
Communication sent by any AESO user to the external user External User’s Team 

 

5.1. Email Notification Sample  
 

5.1.1. PDUP Re-opened  
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6. Appendix  
6.1. Abbreviations 

• AESO – Alberta Electric System Operator 
• CGA – Customer Grid Access 
• PDUP – Project Data Update Package  
• PM – Project Manager 

 

6.2. AESO Contact 
Users can contact customer.connections@aeso.ca for any questions about this user guide, or support 
needed in using the portal. 

 

6.3. Portal Sign-Up or Sign-In Portal URL  
• https://aeso-portal.powerappsportals.com/ 

 

6.4. Email Notifications 
To receive timely notifications, the portal users shall take care that the emails from following senders 
are not marked as spam. 
• svc-azure_aesoportal_notify@aeso.ca. 

 

7. Revision History 
 

Revision Date Comments 
1.0 Dec 06, 2022 Initial version 
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